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 Word Tables the Easy Way

LEARNING LOGS

A.	 1. (iii)		  2. (iv)		  3. (i)			  4. (ii)			  5. (iv)
B.	 1. T		  2. F			   3. T			   4. F			   5. T
C.	 1. Borders and shading		  2. Table Layout			   3. Table			 
	 4. Table Design			   5. Tab
D.	 1.	� To select a group of cells, click on one cell, then drag the mouse to select more cells. Release 

the mouse button when you are done.
	 2.	� When you insert a table a small hollow square at the bottom right corner appears. This is 

called Table Resize Handle. It is used to resize the table. Click on it and drag it around, you 
will see the size of the table change. 

	 3.	Tables in Word documents are commonly used for: 
	 	 •  Organising data in a clear and readable format. 
	 	 •  Comparing values or showing relationships between items. 
	 	 •  Presenting schedules, lists and other data that require clear alignment.
	 4.	Difference between rows and columns:

Rows Columns

A row is a horizontal line of cells in a table. A column is a vertical line of cells in a table.

Each row typically contains data of the 
same type.

Columns contain data organised under specific 
headings.

1.
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	 3.	To insert columns in a document, follow these steps:

		  1   Select the text.

		  2   Click on the Layout tab.

		  3   Click on the Columns drop-down arrow.

		  4   Select the number of columns.
	 4.	Difference between Paragraph border and Page border:

Paragraph Border Page Border

A line around a paragraph or a block of 
text to highlight or separate it visually.

A decorative line or design that frames the 
entire page outside the margins.

	 5.	� The mail merge components are:

	 	 • �Main Document: The template, such as a letter or email, that contains the fixed content.

	 	 • �Data Source: The file, often a spreadsheet or database, that holds the variable information 
like names and addresses.

	 	 • �Merge Fields: The placeholders in the main document that are linked to specific columns 
in the data source and are replaced with unique information for each recipient.

	 1.	� Ritul should use mail merge. It helps her send many invitation letters quickly by adding names 
and addresses to the same letter automatically. This way, she can finish her work fast.

	 2.	� Tarush should use Landscape orientation to achieve this. To do so he should click on Layout 
tab -> Orientation drop-down arrow -> Landscape.

Do it yourself.

�

Do it yourself.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

	 5.	To split a cell in a table, follow the given steps:

		  1   Select the cell you want to split.

		  2   Click on the Table Layout tab.

		  3   Click on Split Cells option.

		  4   Enter the desired number of columns and rows.

		  5   Click on the OK button.

	 1.	� Sarika should improve the look of her table using different Table Styles, Borders and Shading 
features.  

	 2.	� Naman should select the entire table using the Table Move handle. Then, he can go to the 
Table Layout tab and use the Cell Size group to change the column width and row height.

Do it yourself.

�

Do it yourself.

 Word Power Tools

LEARNING LOGS

A.	 1. (iii)		  2. (i)			  3. (iv)		  4. (iv)		  5. (ii)

B.	 1. F		  2. T			   3. T			   4. F			   5. F

C.	 1. Page size	 2. Landscape	 3. Borders and shading		  4. Page border		

	 5. Main Document, Data Source

D.	 1.	� A watermark is used to indicate the document status, add branding or provide an attractive 
background.

	 2.	� Column Formatting involves dividing your document’s text into multiple columns and adjusting 
the width, alignment and layout of those columns.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

2.
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	 3.	To insert columns in a document, follow these steps:

		  1   Select the text.

		  2   Click on the Layout tab.

		  3   Click on the Columns drop-down arrow.

		  4   Select the number of columns.
	 4.	Difference between Paragraph border and Page border:

Paragraph Border Page Border

A line around a paragraph or a block of 
text to highlight or separate it visually.

A decorative line or design that frames the 
entire page outside the margins.

	 5.	� The mail merge components are:

	 	 • �Main Document: The template, such as a letter or email, that contains the fixed content.

	 	 • �Data Source: The file, often a spreadsheet or database, that holds the variable information 
like names and addresses.

	 	 • �Merge Fields: The placeholders in the main document that are linked to specific columns 
in the data source and are replaced with unique information for each recipient.

	 1.	� Ritul should use mail merge. It helps her send many invitation letters quickly by adding names 
and addresses to the same letter automatically. This way, she can finish her work fast.

	 2.	� Tarush should use Landscape orientation to achieve this. To do so he should click on Layout 
tab -> Orientation drop-down arrow -> Landscape.

Do it yourself.

�

Do it yourself.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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	 2.	� Resizing is adjusting the size of a shape to make it fit better on your slide while Rotating is 
adjusting the angle of a shape to make it fit better on your slide.

	 3.	To insert an image using the Stock Images option, follow the given steps:
		  1   Click on the Insert tab.
		  2   Click on the Pictures and select Stock Images option.
		  3   Type the desired keyword in the search box and press the Enter key.
		  4   Select the image you want to insert.
		  5   Click on the Insert (1) button.
	 4.	Difference between Slide Show View and Reading View in PowerPoint:

Slide Show View Reading View

Used to show the presentation to an 
audience.

Used to review the slides easily.

Shows animations, transitions and media 
as they will appear.

Good for easy navigation and exiting quickly.

	 5.	� Normal View is the default view in PowerPoint where slides are created and edited. It is 
useful for writing text, adding pictures or shapes and designing each slide. This view has 
three sections:

	 	 •  Slide Area: The main area where you can work on and design individual slides.
	 	 •  Slides Pane: A side panel that shows Thumbnails of all the slides.
	 	 • Notes Pane: A space below the slide to write notes for the presenter.

	 1.	� Amir can use the Shape Effects feature in PowerPoint to add a shadow behind the shape to 
give it a 3D effect on the slide.

	 2.	� Gayathri can use group feature to combine multiple objects to move them together as a 
single unit.

Do it yourself.

�
Do it yourself.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

Periodic Assessment-1
(Based on chapters 1 & 2)

A.	

Align Bottom Center

Align Bottom Left

Align Center Left

Align Top Left

Align Center

Align Center Right

Align Top Right

Align Bottom Right

Align Top Center

B.	 1.	c  	 2. a		  3. b		  4. e		  5. d
C.	

Column

Cell

Row

 Slides that Impress

LEARNING LOGS

A.	 1. (i)		  2. (iii)		  3. (ii)			  4. (i)			  5. (iii)
B.	 1. T		  2. F			   3. T			   4. F			   5. F
C.	 1. Theme		 2. Text box	 3. SmartArt	 4. Grouped	 5. Slides Pane
D.	 1.	� Notes Page View is used for writing scripts, adding extra details and printing handouts with 

notes.

3.
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	 2.	� Resizing is adjusting the size of a shape to make it fit better on your slide while Rotating is 
adjusting the angle of a shape to make it fit better on your slide.

	 3.	To insert an image using the Stock Images option, follow the given steps:
		  1   Click on the Insert tab.
		  2   Click on the Pictures and select Stock Images option.
		  3   Type the desired keyword in the search box and press the Enter key.
		  4   Select the image you want to insert.
		  5   Click on the Insert (1) button.
	 4.	Difference between Slide Show View and Reading View in PowerPoint:

Slide Show View Reading View

Used to show the presentation to an 
audience.

Used to review the slides easily.

Shows animations, transitions and media 
as they will appear.

Good for easy navigation and exiting quickly.

	 5.	� Normal View is the default view in PowerPoint where slides are created and edited. It is 
useful for writing text, adding pictures or shapes and designing each slide. This view has 
three sections:

	 	 •  Slide Area: The main area where you can work on and design individual slides.
	 	 •  Slides Pane: A side panel that shows Thumbnails of all the slides.
	 	 • Notes Pane: A space below the slide to write notes for the presenter.

	 1.	� Amir can use the Shape Effects feature in PowerPoint to add a shadow behind the shape to 
give it a 3D effect on the slide.

	 2.	� Gayathri can use group feature to combine multiple objects to move them together as a 
single unit.

Do it yourself.

�
Do it yourself.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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 Understanding Excel

LEARNING LOGS

A.	 1. (ii)		  2. (ii)			  3. (i)			  4. (iii)		  5. (ii)
B.	 1. T		  2. F			   3. T			   4. F			   5. T
C.	 1. Ribbon		 2. Column	 3. Formula, Extending		  4. Text		  5. Workbook
D.	 1.	A page made of rows and columns to store and organise data.
	 2.	� Worksheet Tab lets you navigate, rename, add, delete or move sheets while Navigation 

Buttons help you move between worksheet tabs.
	 3.	� To enter data into a worksheet, click on a cell and start typing. The text or numbers will 

appear in the Formula Bar. Press Enter to move down a cell or Tab to move right. To edit 
data, double-click the cell and type the new data.

	 4.	Three important features of Excel are:
	 	 •  Organises data in rows and columns.
	 	 •  Fills in series of data quickly with AutoFill and Flash Fill.
	 	 •  Formats data with different fonts, sizes and colours.
	 5.	The different data types in Excel are:
	 	 •  Text: Includes letters, numbers and special characters like !, @, &, %.
		    Example: Orange!, ABC123@
	 	 • Number: Consists of digits (0–9) and can include decimals and signs (-, +) for calculations.
		    Example: 10, 250, 15.6, -25.
	 	 • � Date and Time: Represents calendar dates and clock times. The default format is dd-mm-

yyyy for dates and hh:mm or hh:mm:ss for time.
		    Example: 21-06-2025, 10:30, 10:25:45.

	 1.	Aarav should use the Number data type.
	 2.	� Shalini can use the Navigation Buttons or keyboard keys (like arrow keys) to move around 

the worksheet.

Do it yourself.

�

Do it yourself.

5.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

 Adding Life to Slides

LEARNING LOGS

A.	 1. (i)		  2. (i)			  3. (ii)			  4. (ii)			  5. (iv)
B.	 1. T		  2. T			   3. T			   4. F			   5. F
C.	 1. Slide Master			   2. Audio Format, Playback	 3. Table	
	 4. Online Videos			   5. Three
D.	 1.	� The advantage of using the grid to insert the table is that as you drag across the columns 

and rows, this lets you see a preview of the table on your slide.
	 2.	� The purpose of inserting video in PowerPoint is to explain complex ideas easily, keep the 

audience interested and make the content more engaging and clearer.
	 3.	� The audio file formats that can be inserted into PowerPoint are AIFF Audio (.aiff), MP3 (.mp3), 

MP4 Audio (.mp4), Windows Audio (.wav) and Windows Media Audio (.wma).
	 4.	� Slide Master is a feature used to change the overall design of a presentation. It allows you 

to edit the background, font and layout for all slides at the same time, instead of making 
changes to each slide separately. This makes it easier to keep your slides consistent and save 
time.

	 5.	To change the table style in a slide, follow the given steps:
		  1   Select the table.
		  2   Click on the Table Design contextual tab.
		  3   Click on the Table Styles drop-down arrow.
		  4   Choose any table style for your table.
.

	 1.	� Ravi can use the Slide Master feature to apply the same font and background to all slides 
and  make the presentation look professional.

	 2.	Nisha should use the Insert feature to add audio and video to her presentation.

Do it yourself.

�
Do it yourself.

4.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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 Understanding Excel

LEARNING LOGS

A.	 1. (ii)		  2. (ii)			  3. (i)			  4. (iii)		  5. (ii)
B.	 1. T		  2. F			   3. T			   4. F			   5. T
C.	 1. Ribbon		 2. Column	 3. Formula, Extending		  4. Text		  5. Workbook
D.	 1.	A page made of rows and columns to store and organise data.
	 2.	� Worksheet Tab lets you navigate, rename, add, delete or move sheets while Navigation 

Buttons help you move between worksheet tabs.
	 3.	� To enter data into a worksheet, click on a cell and start typing. The text or numbers will 

appear in the Formula Bar. Press Enter to move down a cell or Tab to move right. To edit 
data, double-click the cell and type the new data.

	 4.	Three important features of Excel are:
	 	 •  Organises data in rows and columns.
	 	 •  Fills in series of data quickly with AutoFill and Flash Fill.
	 	 •  Formats data with different fonts, sizes and colours.
	 5.	The different data types in Excel are:
	 	 •  Text: Includes letters, numbers and special characters like !, @, &, %.
		    Example: Orange!, ABC123@
	 	 • Number: Consists of digits (0–9) and can include decimals and signs (-, +) for calculations.
		    Example: 10, 250, 15.6, -25.
	 	 • � Date and Time: Represents calendar dates and clock times. The default format is dd-mm-

yyyy for dates and hh:mm or hh:mm:ss for time.
		    Example: 21-06-2025, 10:30, 10:25:45.

	 1.	Aarav should use the Number data type.
	 2.	� Shalini can use the Navigation Buttons or keyboard keys (like arrow keys) to move around 

the worksheet.

Do it yourself.

�

Do it yourself.

5.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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Periodic Assessment-2
(Based on chapters 3 to 5)

A.	 1.	 			  Normal

	 2.	 			  Outline View

	 3.	 			  Slide Sorter

	 4.	 			  Notes Page	

B.	 1.	Record Audio
	 2.	Online Videos
	 3.	Table
	 4.	Slide Master 
C.	

Quick Access Toolbar

Row Heading

Name Box

File Tab

Title Bar

Active Cell
Column Heading

Worksheet Tab

Worksheet Tab Navigation buttons

Formula 
Bar
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Test Sheet-1
(Based on chapters 1 to 5)

A.	 1. (iv)		  2. (iv)			   3. (iii)			   4. (ii)
	 5. (ii)		  6. (i)	
B. 	 1. F		  2. T				    3. T				    4. F
	 5. F		  6. F
C. 	 1. Table		  2. Landscape		  3. Grouped		  4. Online Videos
	  5.	Text		  6. Table 
D. 	 1.	Tables in Word documents are commonly used for: 
	 	 •  Organising data in a clear and readable format. 
	 	 •  Comparing values or showing relationships between items. 
	 	 •  Presenting schedules, lists and other data that require clear alignment.
	 2.	To split a cell in a table, follow the given steps:
	 	 1   Select the cell you want to split.
	 	 2   Click on the Table Layout tab.
	 	 3   Click on Split Cells option.
	 	 4   Enter the desired number of columns and rows.
	 	 5   Click on the OK button.
	 3.	� Column Formatting involves dividing your document’s text into multiple columns and adjusting 

the width, alignment and layout of those columns.
	 4.	Difference between Paragraph border and Page border:

Paragraph Border Page Border

A line around a paragraph or a block of 
text to highlight or separate it visually.

A decorative line or design that frames the 
entire page outside the margins.

	 5.	� Notes Page View is used for writing scripts, adding extra details and printing handouts with 
notes. 

	 6.	To insert an image using the Stock Images option, follow the given steps:
		  1   Click on the Insert tab.
		  2   Click on the Pictures and select Stock Images option.
		  3   Type the desired keyword in the search box and press the Enter key.
		  4   Select the image you want to insert.
		  5   Click on the Insert (1) button.
	 7.	� The purpose of inserting video in PowerPoint is to explain complex ideas easily, keep the 

audience interested and make the content more engaging and clearer.
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	 8.	� Slide Master is a feature used to change the overall design of a presentation. It allows you 
to edit the background, font and layout for all slides at the same time, instead of making 
changes to each slide separately. This makes it easier to keep your slides consistent and save 
time.

	 9.	� Worksheet Tab lets you navigate, rename add, delete or move sheets while Navigation Buttons 
help you move between worksheet tabs.

	 10. The different data types in Excel are:
	 	 •  Text: Includes letters, numbers and special characters like !, @, &, %.
		    Example: Orange!, ABC123@
	 	 • Number: Consists of digits (0–9) and can include decimals and signs (-, +) for calculations.
		    Example: 10, 250, 15.6, -25.
	 	 • � Date and Time: Represents calendar dates and clock times. The default format is dd-mm-

yyyy for dates and hh:mm or hh:mm:ss for time.
		    Example: 21-06-2025, 10:30, 10:25:45.

 Exploring the Online World

LEARNING LOGS

A.	 1. (ii)		  2. (iii)		  3. (iii)		  4. (iii)		  5. (iv)	
B.	 1. T		  2. F			   3. F			   4. T			   5. T
C.	 1.	Paperless	 2. Attach files	 3. Internet	 4. VOIP		  5. Email address
D.	 1.	� Social networking allows people to connect with others, share posts and interact with friends 

and family. Examples of social networking apps are Facebook, Instagram and X (formerly 
Twitter).

	 2.	� Video conferencing lets people communicate face-to-face online using a camera and 
microphone. It is used for online classes, meetings and virtual collaboration. Popular platforms 
include Google Meet, Zoom and Microsoft Teams.

	 3.	� Cloud storage is an online service that lets you save and access files like documents, photos 
and videos from any device with Internet access. It keeps your files safe if your device is lost 
or damaged and makes sharing or collaborating with others easy. Examples of cloud storage 
services are Google Drive, Microsoft OneDrive, Apple iCloud and Dropbox.

	 4.	The basic steps to compose and send an email are:
	 	 1   Click on the Compose button.
	 	 2   Type the recipient’s email address in the To field.

6.

	 	 3   Write the Subject of the email.
	 	 4   Type your message in the Message Body.
	 	 5   Click on the Send button.
	 5.	 Spam Drafts

Contains unwanted emails (junk mail). �Stores the emails you started writing but    
haven’t sent yet.

�Keeps unwanted emails out of your 
inbox.

Allows you to edit and send emails later.

	 1.	Arpitha should use platforms like Facebook and Instagram.
	 2.	Samaira should use the Bcc (Blind Carbon Copy) field while sending the email.

Do it yourself.

�
Do it yourself.

 Smart with Data

LEARNING LOGS

A.	 1. (ii)		  2. (iii)		  3. (iii)		  4. (iv)
B.	 1. F		  2. T			   3. T			   4. F
C.	 1.	Meaningful		 2. Anomaly		  3. Sorting 		  4. Language
D.	 1.	� A survey involves asking clear questions to individuals to collect useful information. It helps 

gather facts, numbers, or observations to gain new understanding and useful information. 
Surveys are one of the most common ways to collect data.

	 2.	� Data processing is the act of converting raw data into meaningful and useful information. 
This process involves a series of actions such as cleaning, organising and analysing data to 
extract valuable insights for decision-making.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

7.
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	 	 3   Write the Subject of the email.
	 	 4   Type your message in the Message Body.
	 	 5   Click on the Send button.
	 5.	 Spam Drafts

Contains unwanted emails (junk mail). �Stores the emails you started writing but    
haven’t sent yet.

�Keeps unwanted emails out of your 
inbox.

Allows you to edit and send emails later.

	 1.	Arpitha should use platforms like Facebook and Instagram.
	 2.	Samaira should use the Bcc (Blind Carbon Copy) field while sending the email.

Do it yourself.

�
Do it yourself.

 Smart with Data

LEARNING LOGS

A.	 1. (ii)		  2. (iii)		  3. (iii)		  4. (iv)
B.	 1. F		  2. T			   3. T			   4. F
C.	 1.	Meaningful		 2. Anomaly		  3. Sorting 		  4. Language
D.	 1.	� A survey involves asking clear questions to individuals to collect useful information. It helps 

gather facts, numbers, or observations to gain new understanding and useful information. 
Surveys are one of the most common ways to collect data.

	 2.	� Data processing is the act of converting raw data into meaningful and useful information. 
This process involves a series of actions such as cleaning, organising and analysing data to 
extract valuable insights for decision-making.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

7.



CodePilot (Ver. 5.0)-V (Answer Key)12

	 3.	� Sorting data means putting information into a clear and organised order. For example, you 
can arrange books on a shelf from A to Z or line up numbers from the smallest to the largest.

	 	 Sorting data can be done in different ways:
	 	 i.  Alphabetical Order: Arranging words like names or subjects from A to Z or Z to A.
	 	 ii. � Numerical Order: Arranging numbers like marks, heights or scores from smallest to largest 

or vice versa.
	 	 iii.  Date Order: Arranging events or timelines from oldest to newest or newest to oldest.
	 4.	� Data can support decision-making by providing useful information that helps choose the 

best option, make predictions and ensure decisions are based on facts and trends rather 
than guesses.

	 1.	� I would identify trends by noting which hobbies are most preferred by students and use this 
information to plan school activities that align with their interests.

	 2.	� I would look at the most popular extracurricular activities from the survey and suggest new 
clubs or activities based on students’ interests and preferences.

Do it yourself.

�
Do it yourself.

Periodic Assessment-3
(Based on chapters 6 & 7)

A.	

Trash

Sent

Inbox

Compose

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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B.	
orangeeducation@gmail.com

User Name Domain Name

C.	 1.	Alphabetical Order 			   2. Numerical Order			  3. Date Order 
D.	 1.	Sorting
	 2. Trend
	 3. Anomaly

 Scratch Meets AI

LEARNING LOGS

A.	 1. (iii)		  2. (i)			  3. (ii)			  4. (iv)
B.	 1. F 		  2. T			   3. T			   4. F
C.	 1. Multiple	 2. Broadcast, Receive		  3. Variables		  4. Talk
D.	 1.	� Broadcast and Receive blocks allow sprites to communicate with each other without being 

directly connected. This is useful for controlling different parts of a story or game.
	 2.	� Variables can store numbers, text or other information that needs to be updated or referenced 

throughout your project.
	 3.	� The translation is possible through a collaboration between Scratch and Google. It internally 

uses Google Translate to perform the translations.
	 4.	� The Video Sensing extension lets you use your webcam to control your project. It can detect 

movement in front of the camera and use it to make things happen in the game, like moving 
a sprite or triggering an action.

	 5.	Difference between Global Variables and Local Variables:

Global Variables Local Variables

Global variables are created on any sprite 
and can be accessed or modified by other 
sprites used in the project.

Local variables are created for a specific sprite 
and can only be used by that sprite.

These variables are created by choosing 
‘For all sprites’.

These variables are created by choosing ‘For 
this sprite only’.

8.
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	 1.	� Vasudha should use Broadcast and Receive blocks to achieve this.
	 2.	� Swapnil should click on the Add Extension button and choose the Video Sensing extension 

to do so.

Do it yourself.

�
Do it yourself.

 Creating Apps with MIT App Inventor

LEARNING LOGS

A.	 1. (i)		  2. (iii)		  3. (i)			  4. (iii)		  5. (ii)
B.	 1. F		  2. T			   3. F			   4. T			   5. F
C.	 1. Mobile		 2. Web		  3. Coding		 4. Properties		  5. Variables
D.	 1.	� Apps are software program that you can use on a smartphone, tablet or computers to do 

specific tasks like learning, playing games, chatting or watching videos.
	 2.	� Variables block store values that can change while the app runs. You can create, set and get 

variable values.
	 3.	The two features of mobile apps are:
	 	 • � Easy to Use: Apps are simple and user-friendly, allowing even children to learn quickly by 

tapping icons.
	 	 •  �Safe and secure: Verified apps protect your data and let you control settings like 

notifications and privacy.
	 4.	The three most commonly used UI components in MIT App Inventor are:
	 	 •  Buttons: Triggers an action when tapped, like opening a screen or showing a message.
	 	 • � Label: A label displays text on the screen. It can be used to show messages, instructions, 

or even the result of an action.
	 	 •  �TextBox: A TextBox allows users to enter text. This is useful when you need to collect 

information from the user, such as their name or email.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

9.

	 5.	Difference between Native Apps and Web Apps:

Native Apps Web Apps

A native app is software built for a specific 
operating system, like iOS or Android.

A web app is a software program that works 
in a web browser like Chrome or Safari.

Takes up space on your device Opened directly in a browser

	 1.	Ravi should use Label component to display the message.
	 2.	Rashita should use educational apps to get started with basic coding.

Do it yourself.

�
Do it yourself.

   AI Industry 5.0: Smart Robots

LEARNING LOGS

A.	 1. (iii)		  2. (ii)			  3. (iii)		  4. (iv)		  5. (i)
B.	 1. T		  2. T			   3. F			   4. T			   5. F
C.	 1.	Entertainment			   2. Education				    3. Healthcare
	 4.	Sensors				    5. Military
D.	 1.	� Motors are actuators that generate mechanical motion, driving the robot’s joints, wheels or 

limbs.
	 2.	� Delivery robots use GPS, sensors and AI to move goods safely. They deliver food, parcels and 

medicines in urban areas. These robots save time, cut costs, are eco-friendly and work with 
little human contact.

	 3.	� Industry 5.0 is the next stage of industrial growth where artificial intelligence (AI) and human 
skills work together. Unlike Industry 4.0, which focused on machines and automation Industry 
5.0 brings people and machines together.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

10.
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	 5.	Difference between Native Apps and Web Apps:

Native Apps Web Apps

A native app is software built for a specific 
operating system, like iOS or Android.

A web app is a software program that works 
in a web browser like Chrome or Safari.

Takes up space on your device Opened directly in a browser

	 1.	Ravi should use Label component to display the message.
	 2.	Rashita should use educational apps to get started with basic coding.

Do it yourself.

�
Do it yourself.

   AI Industry 5.0: Smart Robots

LEARNING LOGS

A.	 1. (iii)		  2. (ii)			  3. (iii)		  4. (iv)		  5. (i)
B.	 1. T		  2. T			   3. F			   4. T			   5. F
C.	 1.	Entertainment			   2. Education				    3. Healthcare
	 4.	Sensors				    5. Military
D.	 1.	� Motors are actuators that generate mechanical motion, driving the robot’s joints, wheels or 

limbs.
	 2.	� Delivery robots use GPS, sensors and AI to move goods safely. They deliver food, parcels and 

medicines in urban areas. These robots save time, cut costs, are eco-friendly and work with 
little human contact.

	 3.	� Industry 5.0 is the next stage of industrial growth where artificial intelligence (AI) and human 
skills work together. Unlike Industry 4.0, which focused on machines and automation Industry 
5.0 brings people and machines together.

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK

10.
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	 4.	� Home robots assist with household tasks, providing convenience and automation. With 
advances in AI, sensors and connectivity, they are now smarter, more user-friendly and 
versatile.

	 5.	� Robotics improves healthcare by enhancing surgery precision, providing prosthetics, aiding 
rehabilitation and supporting recovery with robotic exoskeletons and Military robots assist 
with surveillance, combat and medical support. Drones track enemies, while armed robots 
handle high-risk tasks, like MAARS and DOGO.

	 1.	� Home robots would be suitable for this because with advances in AI, sensors and connectivity, 
they are now smarter, easier to use and capable of many functions.

	 2.	� Robotics in agriculture boosts productivity by automating tasks like harvesting and seed 
control, reducing dependency on manual labour and environmental conditions.

Do it yourself.

�
Do it yourself.

Periodic Assessment-4
(Based on chapters 8 to 10)

A.	 1.	b		  2. a			   3. c

B.	

Palette Pane

Viewer Pane Components Pane

Properties Pane

COMPETENCY-BASED QUESTIONS

LAB LEARNING

CODE CHECK
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C.		  1. Sensors 
		  2. Actuators
		  3. Motors
		  4. Controllers

Test Sheet-2
(Based on chapters 6 to 10)

A.	 1. (iii)		  2. (iii)		  3. (ii)	 		  4. (ii) 		  5. (i)			  6. (iv)
B.	 1. F		  2. T			   3. T			   4. F			   5. F			   6. F
C.	 1.	Attach files				    2. Sorting			  3. Talk
	 4.	Web					     5. Sensors		  6. Variables
D. 	 1.	� Cloud storage is an online service that lets you save and access files like documents, photos 

and videos from any device with Internet access. It keeps your files safe if your device is lost 
or damaged and makes sharing or collaborating with others easy. Examples of cloud storage 
services are Google Drive, Microsoft OneDrive, Apple iCloud and Dropbox.

	 2.	� Social networking allows people to connect with others, share posts and interact with friends 
and family. Examples of social networking apps are Facebook, Instagram and X (formerly 
Twitter).

	 3.	� Sorting data means putting information into a clear and organised order. For example, you 
can arrange books on a shelf from A to Z or line up numbers from the smallest to the largest.

	 	 Sorting data can be done in different ways:
	 	 •  Alphabetical Order: Arranging words like names or subjects from A to Z or Z to A.
	 	 • � Numerical Order: Arranging numbers like marks, heights or scores from smallest to largest 

or vice versa.
	 	 •  Date Order: Arranging events or timelines from oldest to newest or newest to oldest.
	 4.	� Data processing is the act of converting raw data into meaningful and useful information. 

This process involves a series of actions such as cleaning, organising and analysing data to 
extract valuable insights for decision-making.

	 5.	� Variables can store numbers, text or other information that needs to be updated or referenced 
throughout your project.

	 6.	� The Video Sensing extension lets you use your webcam to control your project. It can detect 
movement in front of the camera and use it to make things happen in the game, like moving 
a sprite or triggering an action.

	 7.	The two features of mobile apps are:
	 	 • � Easy to Use: Apps are simple and user-friendly, allowing even children to learn quickly by 

tapping icons.
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	 	 • � Safe and secure: Verified apps protect your data and let you control settings like 
notifications and privacy.

	 8.	The three most commonly used UI components in MIT App Inventor are:
	 	 • � Buttons: Triggers an action when tapped, like opening a screen or showing a message.
	 	 •  �Label: A label displays text on the screen. It can be used to show messages, instructions, 

or even the result of an action.
	 	 • � TextBox: A TextBox allows users to enter text. This is useful when you need to collect 

information from the user, such as their name or email.
	 9.	� Industry 5.0 is the next stage of industrial growth where artificial intelligence (AI) and human 

skills work together. Unlike Industry 4.0, which focused on machines and automation Industry 
5.0 brings people and machines together.

	 10. �Robotics improves healthcare by enhancing surgery precision, providing prosthetics, aiding 
rehabilitation and supporting recovery with robotic exoskeletons and Military robots assist 
with surveillance, combat and medical support. Drones track enemies, while armed robots 
handle high-risk tasks, like MAARS and DOGO.


